
Break in the Chain: An Excel-Driven Supply 
and Demand Student Case Study of the Beef 

Processing Industry During the COVID-19 
Pandemic

Christopher S. Decker† Jeff Bredthauer†

             2024 Journal of Economics Teaching

†Universtiy of Nebraska at Omaha

In this paper, we develop a simple Excel-driven supply and demand spreadsheet model that 
instructors can easily implement in their classes to help students understand the interlinkages 
within markets across supply chains.  For this exercise, we use  a specific example involving 
the beef production and processing industry during the COVID-19 pandemic.  Presented as a 
case study aimed primarily at principles-level economics and business students, but valuable at 
higher levels as well, this Excel framework provides a graphical, and simulatable, visualization 
of how price and output dynamics play out across several markets linked through a supply 
chain.  Hence, this lesson teaches students how markets are connected, as well as provides 
deeper insights about real-world market situations beyond common perceptions formed when 
reading news media accounts.

https://creativecommons.org/licenses/by/4.0/


32

Decker, Bredthauer / Journal of Economics Teaching (2024)

1. Introduction

Recent events have highlighted the importance of market inter-linkages through supply 
chains. For example, in the initial months of the COVID-19 pandemic, surges in demand for 
hand sanitizer, personal protective equipment, toilet paper, and computer hardware strained 
production and global supply chains (Gereffi, 2020). Brexit is another example. Garnett, 
Doherty, and Heron (2020) discuss the supply chain disruptions in food distribution in the UK 
post-Brexit. Ke et al. (2022) demonstrate substantial increases in shipping costs associated with 
moving produced goods to retail establishments, which is roughly 94 percent of total supply 
chain costs in the UK, post-Brexit. It seems then, that economics and supply chain issues are 
inherently linked (Ketokivi & Mahoney, 2020).

Incorporating supply chain issues when teaching economic principles courses would 
seem to be a valuable addition. Zheng and Ramse (2021) offer some instructional examples 
involving supply shortages of toilet paper and oil and their impact on markets using a supply 
and demand framework. Our contribution is to provide an Excel-based, animated supply chain 
simulation model based on a specific case example, described below, that can be readily 
incorporated into such a course. The case is based on the beef production and processing 
market that was severely disrupted by COVID-19 outbreaks in Spring and Summer of 2020. At the 
time, many stories appeared in the popular press regarding this disruption as processing plants 
closed and shortages occurred. Most of those stories focused on potential anticompetitive 
behavior by meat processors. We highlight this because the dynamics of the market at the time 
could also easily and logically be explained by simple supply and demand analysis that any 
student studying economics principles can understand. So, in addition to providing a valuable, 
real-world case example for students to consider, we also offer students the opportunity to 
appreciate how standard economic principles can be used to explain real-world phenomena, 
and therefore, not necessarily take at face value things they might read in news media accounts. 

The remainder of this paper is organized as follows. In Section II we provide a brief 
overview of the beef market case study during COVID-19. In Section III we provide an overview 
of the pedagogical literature that illustrates the benefits of using spreadsheet applications such 
as Excel to explain economic concepts. In Section IV, we present our basic supply and demand 
model and its implementation in Excel. In Section V, we offer an illustrative example of how 
the model works in Excel, and in Section VI we outline our suggestion for implementing this 
case into an economic principles class. In Section VII we offer some background data on the 
applicability of supply and demand for this model. Section VII concludes. 

2. The Beef Industry During the Early Stages of COVID-19

In Spring and Summer of 2020, many companies were experiencing serious disruptions 
due to shutdowns, low consumer spending, and labor force shortages due to COVID-19 
outbreaks. The meat and poultry processing industry in the United States was extremely 
hard hit by outbreaks among workers, particularly in the Midwest, forcing facilities to close 
temporarily and companies to re-route production and distribution to other plants. The result 
led to substantial reductions in processed meat products. Grocery store shelves were at times 
empty, customers were required to limit their purchases, and prices rose substantially. At 
the same time, the prices processing companies were paying for cattle, hogs, and fowl were 
plummeting. Livestock could not be sold profitably and, as a result, many farmers and ranchers 
ended up having to euthanize much of their livestock. Figure 1 below illustrates these pricing 
patterns.
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Figure 1. Prices for Live Cattle (left) and Beef (right)

Source: NASDAQ for live cattle. US Bureau of Labor Statistics for beef. 

The combination of escalating prices at grocery stores and dropping prices for livestock 
led to public concerns about possible price manipulation on the part of meat processors, which 
in turn, encouraged government investigations into the matter. As reported by the press, the 
allocations focused attention on meat and poultry producers exploiting their market power 
to extract profits from farmers, ranchers, and consumers (see, e.g. https://www.politico.com/
news/2020/05/25/meatpackers-prices-coronavirus-antitrust-275093.) One article stated: “This 
isn’t the way supply and demand is supposed to work.” (See https://thecounter.org/covid-19-
meat-plant-closures-food-prices-cattle/).1 

The purpose of this paper is neither to refute nor support anticompetitive behavior 
by meat and poultry processors. Rather, it’s to offer a spreadsheet-driven case study whereby 
students can see how markets modeled using simple supply and demand, where markets 
are linked through a supply chain, can explain the pricing behavior of this market during the 
pandemic. As such, there is a two-fold gain. First, they can develop a deeper understanding 
of the richness of the (seemingly simple) supply and demand model. Second, students can 
see that the pricing behavior described above can be easily explained by supply and demand 
without a need to appeal directly to anticompetitive behavior as presented in the press. By 
teaching students the nuances of these complexities, they can gain a better understanding 
of how interlinked economies are deeply intertwined with supply chain issues; issues that in 
today’s global economy, are at the forefront of business concerns and government policy.

3. Spreadsheets as a Pedagogical Tool to Explain Economic Concepts

The use of spreadsheets, particularly Microsoft Excel, as a teaching tool has a rich

1Students might find the following video titled “I almost ended my life because of the corrupt & rigged beef 
industry” available on YouTube: https://www.youtube.com/watch?v=BeQIBde5_4I. like other references, it focuses 
on the potential for market power abuse. It has the advantage of a video format, a format preferred by many 
students.

https://www.politico.com/news/2020/05/25/meatpackers-prices-coronavirus-antitrust-275093
https://www.politico.com/news/2020/05/25/meatpackers-prices-coronavirus-antitrust-275093
https://thecounter.org/covid-19-meat-plant-closures-food-prices-cattle/
https://thecounter.org/covid-19-meat-plant-closures-food-prices-cattle/
https://www.youtube.com/watch?v=BeQIBde5_4I
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 and varied history. It’s been used to teach numerous topics such as statistics, mathematics, 
and physics as well as economics. Such applications have been used for years to illustrate 
economics to students in both microeconomics and macroeconomics. Many applications 
are also presented at the intermediate and advanced levels. In the realm of microeconomics, 
authors such as Barreto (2009), Ghosh and Ghosh (2001), Larson and Swofford (2015), Nguyen 
and Gilbert (2019), Sala-Velasco (2021), Silva and Zabadia (2013), and Tohamy and Mixon (2004), 
just to name a few, have offered examples. Use in macroeconomics include Barreto (2015) and 
Strulik (2004).

Excel-based applications at the principles level are also represented in the literature. 
Mixon and Tohamy (2001) provide a number of examples and Ghosh (2020) offers an Excel 
application illustrating the competitive firm’s shut-down decision.

Excel-based spreadsheet applications are viewed by many as effective learning devices. 
Many are still being developed after over three decades of its inception as a pedagogical tool. 
However, the likelihood that spreadsheet programs like Excel are truly effective in promoting 
learning is an under-researched area. That said, we do find some research indicating it enhances 
comprehension. 

Barreto (2015) used test score results from the ETS Major Field Test in economics from 
DePauw University economics students who were required to use Excel-based spreadsheet 
applications in their intermediate microeconomics classes (the treatment group) and compared 
those scores with students who were in sections that did not require such applications (the 
control group). Those findings indicated that the treatment group performed significantly 
better than the control group. Moreover, through classroom experimentation, Cagle, Glasgo, 
and Hyland (2010) found that students who were required to use spreadsheet applications in 
introductory finance classes performed better on exams than those students who were not. 

While Excel-based models to aid in teaching are numerous and there is some evidence 
that it’s an effective learning platform to employ, Excel itself isn’t the primary focus of our 
contribution. Our focus is mostly on how market linkages through a supply chain can be 
effectively presented using graphical simulation and animation. Excel is mainly a convenient 
tool that aids this exposition. 

While it is true that the case presented in this paper could be presented in standard “chalk 
and talk” fashion, a more interactive approach where students work within the spreadsheet 
environment has advantages. Carr, Palmer, and Hagel (2015) and Miller and Metz (2014) found 
that active learning where students are engaged participants in the classroom through the 
use of in-class written exercises, problem sets, audience-response, and class discussions, 
generates improved learning outcomes. Moreover, research by Baylor and Ryu (2003) found 
that showing economic concepts using animation techniques is beneficial to learning. Having 
an Excel platform that allows students to use the spreadsheet by simulating model changes 
and visualizing market changes might improve their understanding of economic models, even 
one as simple as supply and demand.

4. Supply and Demand, the Supply Chain, and Implementation in Excel

Consider three markets defined by supply and demand frameworks: The cattle industry, 
the beef processing industry, and the grocery industry. The beef processing industry is the 
intermediary link between (downstream) grocers and (upstream) ranchers in that grocers 
buy dressed beef from the processor and processors buy cattle from ranchers. The models are 
deliberately kept simple with linear demand and supply functions similar to what would be 
found in any standard principles text.
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The beef processing industry. We start with the processing market. Let the demand 
and supply curves be:

 (1) 		  Demand: Qb =  g - h ✳ Pb	

 (2)		  Supply:  Qb  =  m ✳ Pb - w		

where Pb and Qb are for the price and quantity of processed beef and g, h, w, and m are model 
parameters. As we will see, the shift parameter, w, plays a significant role in the model. An 
increase in w leads to a reduction in the production of processed beef. This can occur when 
there is limited labor available to work in processing plants, which, in turn, will put upward 
pressure on prices for processed beef. This will likely look a little strange to students at first. 
However, as part of the class exercise (described below), the instructor will need to offer the 
rationale for it. It might be instructive, for example, to also show the inverse supply function:  

𝑃𝑃𝑏𝑏  = ( 1
𝑚𝑚) ∗ 𝑄𝑄𝑏𝑏 + 𝑤𝑤

𝑚𝑚 

 

has a way to illustrate the cost effect, w, on the market.

The cattle industry. The demand and supply equations for the cattle industry are 
defined as:

(3) 	               Demand:  Qc =  a - d ✳ Pc+θQb						   

(4)		  Supply:  Qc =  e + ƒ ✳ Pc	 	

where Pc and Qc are for price and quantity of cattle and a, d, θ, e, and f are model parameters. 
The simple innovation here is that cattle demand depends on the equilibrium quantity of 
processed beef: Qb  The model is set up such that if equilibrium processed beef production 
changes, it would impact demand in the cattle industry. For example, if equilibrium beef 
quantity declined, either due to reduced demand for beef products by groceries, or increased 
costs of beef production, then demand for cattle would decline as fewer cattle are needed by 
processors.2

The grocery industry. The demand and supply equations for the grocery industry are 
defined as:

(5)	 Demand:  Qg =  n - r ✳ Pg			 

(6) 	 Supply:  Qg  =  s + u ✳ Pg + α Qb				  

where Pg and Qg are for price and quantity of beef sold at grocery stores and n, r, α, s, and 
u are model parameters. The grocery market is linked to the processing industry through 
the equilibrium quantity of processed beef: Qb The model is set up such that if equilibrium 
processed beef production changes, beef available for sale to customers at grocery stores will 
be impacted. For example, if equilibrium beef quantity declines, either due to reduced demand 
for beef products by groceries or increased costs of beef production, then the supply of beef 
available at grocery stores declines. This shifts the supply curve to the left, implying a higher 

2  We chose to connect the cattle market with processing through output because doing so through price could be 
confusing and problematic. An increase in processing prices could be due to an increase in supply costs (reducing 
output) or an increase in demand (increasing output). Using equilibrium processing output in the cattle market 
allows us to focus on the “need” for cattle based on the production of dressed beef.

*

*

*

*
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cost for essed beef, putting upward pressure on retail beef prices.3

Equilibrium conditions. Equilibrium quantities and prices are provided below:

(7) beef processing industry:  Pb  =             ,  Qb   = 

  

(8) cattle industry:   Pc =                         ,  Qc  = a -d ✳ (   )+(   )θQb

(9) grocery industry: qg   =                     , Qg  = n - r ✳ (   )+(   )αQb

Specific application to our case study suggests that the operative variable in our modeling 
framework is w, the principal shift parameter in the beef processing supply function. An 
increase in w, for example, would imply higher costs of production, due perhaps to limited 
availability of labor, which would drive wages higher. From the equilibrium conditions, we can 
readily see that Qb  falls and Pb increases. This in turn drives Qc  down and, importantly, drives 
Pc down as well. Thus, reduced beef processing production reduces prices received by cattle 
ranchers. Moreover, less processed beef is available to be sold to grocery stores. Hence, Qg falls 
and Pg increases.

While the algebra is manageable and the intuition fairly clear, the complexity of 
implementing these equations in Excel itself can be daunting to many students, particularly 
those studying at the principles level. Therefore, as we suggest below, our recommendation 
would be to employ the spreadsheet we’ve provided and have students focus on the graphical 
representations of the models and how certain parameters in the model will impact the figures. 
Again, as suggested by Baylor and Ryu (2003), such an approach can prove pedagogically 
beneficial.

Implementation in Excel. The Excel file we have constructed and made available to 
interested users, “supply chain with supply and demand.xlsx,” is organized as follows. Figure 
2 is a screenshot of the main body of our Excel file, illustrating the baseline scenario. Supply 
and demand figures for all three markets occupy cells A1 through P21. As argued above, a 
visual depiction of the market is often the most effective means of conveying concepts. Indeed, 
seeing how supply and demand curves shift is essential to understanding this case and we 
recommend that the focus be there. 

3 In principle, we could have modeled this effect by including the equilibrium price of dressed beef. The higher 
the price of dressed beef would also imply a leftward shift in grocery supply. In such a case we would want a 
positive coefficient associated with processing prices.  We chose to model the link through equilibrium processing 
quantity to be consistent with the cattle market impact.

g+w
h+m

 gm-hw
h+m

**      

a-e+θQb

d+ƒ
* a-e

d+f *

*

*
f

d+f

n-s-αQb

r+u
* *

n-s
r+u

r
r+u

*

** *
*

*
*
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Figure 2. Model Parameters

By way of spreadsheet construction, the figures are derived from supply and demand 
calculations for all three markets embedded in the spreadsheet starting in column T in our Excel 
file (not shown in the screenshots). Each market is assumed to have output values between 
0 and 100. For the cattle market, we have baseline demand and supply values in columns U 
and V in the file. The alternative demand is in column W of the file. For the beef processing 
market, baseline demand and supply values are in Z and AA of the file. The alternative supply 
is in column AB of the file. Finally, for the grocery market, baseline demand and supply values 
are in AE and AF with its alternative supply in AG of the file. The equations for each reflect the 
equations (1) through (6).4 

In A25 through F29 we have our numerical parameters for our baseline model.5 In J31 
we have an alternative parameter for w (see equation (2) above). The slide bar in K31, as will be 
discussed later, is used by students to visualize how changes in w impact all three markets. 

The baseline values for equilibrium quantities are in I26:I29 and baseline values for 
equilibrium prices are in L26:L29. For our alternative values, the equilibrium values are in J26:J29 
for quantities and M26:M29 for prices. 

 Figure 3. Equilibrium Formulas

4 The equations in Excel are coded as inverse demand and inverse supply functions. This provides us with control 
over the Q axis.
5 The model parameters for all three markets have been set to approximate the data presented in Figure 1. The 
baseline equilibrium price for the cattle market can be interpreted as $120 per cwt (i.e., hundredweight), the 
baseline equilibrium wholesale processed beef price is $3.00 per lb., and the retail price of beef sold at groceries 
is $4.00 per lb.

Decker, Bredthauer / Journal of Economics Teaching (2024)
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Figure 3 shows the Excel formulas and the equilibrium outcomes. There are a few 
important features of these formulas. First, note that for the cattle market, we reference I27 
(baseline) and J27 (alternative) in the price and quantity formulas. This links the market to the 
equilibrium price and quantity values in the beef processing market’s equilibrium output. Thus, 
cattle price and quantity are directly impacted by output conditions in the beef processing 
industry. Similarly, notice that I27 (baseline) and J27 (alternative) are in the price formulas for 
the grocery market. Thus, grocery store prices and quantity of beef are also directly impacted 
by output conditions in the beef processing industry.

Note further that the equations for the baseline and alternative price formulas for the 
beef processing market (L27 and M27) differ in one subtle but critically important way; the 
baseline formula references D27, the baseline value of w in the processed beef market’s supply 
curve (equation (2)). 

In the alternative formula cell M27 the reference link is J31, the alternative value for w. 
What we have done here is allow for a “shock” to supply conditions in the beef market in the 
alternative case through supply. The idea is that with a higher w, supply will shift to the left. As 
workers become scarce due to illness, the cost of labor is effectively increased as other plants 
not impacted by COVID-19 need to increase production by deploying more labor, bidding 
wages up. The result: Higher processing costs.

5. An Illustrative Simulation

In this section, we provide the reader with an illustrative simulation to show how the 
model works. Within the Excel file, if we change J31 from 0 to 10, we can see the impact on all 
three markets from increasing w to 10. Figure 4 is a screenshot of this simulation.

When w increases to 10, the Excel table reports that beef processing prices increase 16.67 
percent from baseline and quantity falls 16.67 percent. Cattle prices in turn declined 16.67 
percent from baseline and quantity declined 1.85 percent. The quantity of beef sold at grocery 
stores declined by 3.85 percent but prices paid by customers for beef increased by 25 percent. 
Arguably, with the focus on graphical representation, the specific numbers are not as critical as 
the direction of the price and quantity changes. 

Figure 4. Simulation with w = 10

Decker, Bredthauer / Journal of Economics Teaching (2024)
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Thus, the simulation does illustrate that one need not conclude too quickly that anti-
competitive pricing was necessarily being exercised by the meat processing industry. Simple 
supply and demand does offer an explanation. The next step is to develop a class exercise that 
allows students an opportunity to visualize this for themselves.

6. Class Application

There are many ways an instructor can implement this case. Our outline here is simply 
a suggestion. Since the spreadsheet is already set up, no prior knowledge of Excel coding 
is necessary. However, this exercise is best presented after students are taught the basics of 
supply and demand as is done in all principles courses. Some modest algebraic enhancements 
would be valuable as well so that equations like (1) through (6) make sense to students.6

With our implementation, we envision an in-class scenario where students have access 
to Excel on their computers.7 However, this framework allows for some student interaction with 
the Excel file and an opportunity to visualize market movements in a dynamic setting as they 
simulate alternative outcomes. Our suggested steps are as follows:

1.	 The instructor should articulate that this exercise will teach students how markets 
are linked to one another (in this case, through a supply chain), and how supply and 
demand can be used to explain complex economic phenomena. 

2.	 The instructor then provides the basic setup of the case, referencing the news story 
cited in the introduction as a way to provide real-world context. The instructor can 
highlight that the story is primarily concerned that the beef processing industry is 
taking advantage of its market power during the COVID-19 pandemic to increase 
consumer beef prices and undercut cattle prices, thereby growing its profits. An 
explanation of how the story seems to center around the allegation that such 
behavior violates basic competitive markets as modeled by supply and demand 
would be appropriate to include. The instructor can then pose the question: Can 
supply and demand explain the behavior of these markets?

3.	 The instructor then invites students to open a version of the Excel file on their 
computer.

4.	 The instructor describes equations (1) through (6). This can be done on the board, 
through PowerPoint or some other means. A written document provided to the 
student is recommended as well.

5.	 The instructor then introduces students to the numerical model parameters and the 
spreadsheet, emphasizing how they relate to the supply and demand figures, how 
links the markets together, and the role w plays in the beef market.8 

6.	 The instructor then has students simulate a shock to beef processing supply by using 
the scroll bar in cell K31.9 By moving the bar to the right, or by clicking on the right-

6 This also affords instructors to impress upon students the interlinkages between markets through supply chains. 
As such, an instructor could choose to do this exercise after a factor markets lecture where the labor markets are 
shown to link with product markets. However, in our judgment a standard background with supply and demand 
is sufficient for this exercise.
7 If students do not have access to a computer in class, then this exercise could be constructed as a lab assignment 
to be done outside of class. Written instructions similar to the description above and access to the Excel file would 
be required.
8 For more advanced courses, the instructor could have the students code the formulae in Excel as outlined in our 
spreadsheet. However, for principles-level students, we would not advocate this. Rather, a discussion of how the 
formulae work is likely sufficient and will focus attention on concepts as opposed to coding.
9 Inserting a scroll bar in Excel is relatively simple. We outline that procedure in the Appendix.

Decker, Bredthauer / Journal of Economics Teaching (2024)
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hand arrow, students will notice that the value of w in J31 increases. This, in turn, 
shifts the beef supply curve to the left to reflect the market’s difficulty in supplying 
processed beef due to Covid outbreaks among workers at processing plants.

7.	 Students will then notice the reduction in demand for cattle. The instructor should 
then invite a class discussion with a focus not only on what is happening but why 
the markets are changing. This can lead to the conclusion that with less processing 
taking place, fewer cattle will be purchased. The result is that demand for cattle will 
decrease and cattle prices will fall for cattle farmers.

8.	 At the same time, students will notice that the supply of processed beef available for 
purchase at grocery stores declines. Again, the instructor can invite class discussion 
about why this is happening, guiding students to the conclusion that because there 
is less production from beef processors, there is less available to ship to grocery 
stores. The result is that consumers observe higher prices for beef products.

9.	 At this point, the instructor could return to Figure 1 above where the data show 
the increase in consumer prices and the fall in cattle prices and offer a conclusion 
that supply and demand, with supply chain links incorporated into the model, can 
indeed explain what was experienced in 2020 at the height of the pandemic (i.e., 
increased prices for processed meat).

10.	Finally, it would also be beneficial for the instructor to close out this exercise by 
emphasizing that this case is not intended to teach students about the beef market, 
but rather how this framework can be used in other applications involving supply 
chain disruption.  For example, one consequence of Brexit, as referenced above, has 
been increased shipping costs due to trade restrictions. This will have implications 
in both upstream markets, as suppliers may receive fewer new orders, and in 
downstream markets, as prices adjust.

7. Market Structure and the Applicability of Supply and Demand

By employing a supply and demand framework we are assuming all three models are 
competitive, characterized by many buyers and sellers, little product differentiation, and ease 
of firm entry. The question naturally arises: Are these markets competitive in nature? 

Popular measures of industry structure, such as Herfindahl-Hershman Indexes, while 
plentiful for manufacturing markets, are less accessible for agricultural and service-based 
industries. However, IBISWorld publishes a large variety of industry reports that provide 
information on each industry’s competitive structure, from seller concentration to entry barrier 
conditions.10  Seiler’s (2023a) report “Beef Cattle Production in the US” describes this industry as 
having exceptionally low seller concentration due to a large number of family-owned ranches 
in the US. As of February 2023, the report lists 738,730 ranching establishments with little 
evidence of any concentration of a few large ranch operations in the market. According to the 
report, there are some entry barriers but product differentiation appears fairly limited.

Diment’s (2022) report “Supermarkets & Grocery Stores in the US” describes the industry 
as highly fragmented, characterized by about one-third of some 87,571 establishments 
employing fewer than five workers. Seller concentration is relatively low with the top three 
operators, Kroger, Albertsons, and Publix Super Markets, accounting for about 29 percent 
of industry revenue in 2022. There are a few entry barriers but competition is fairly intense 
between firms.

10 IBISWorld is a subscription-based service that many university libraries have access to (IBISWorld.com). There are 
other services available, such as Standard & Poor’s Industry Surveys.

Decker, Bredthauer / Journal of Economics Teaching (2024)
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These reports suggest there’s reason to consider grocery stores and beef cattle markets 
as competitive, justifying a supply and demand model. The beef processing market is a bit 
different as there is no separate report on beef markets specifically. However, there is Seiler’s 
(2023b) report “Meat, Beef & Poultry Processing in the US”. JBS USA Holdings, Tyson Foods, and 
Cargill are the three top competitors in the market and account for about 40 percent of industry 
revenue in 2023. Barriers to entry are present as startups require substantial amounts of land 
and capital. However, product differentiation is limited. While the top three firms do capture 
40 percent of the market, there are about 6,333 total establishments in the US. Due to this, and 
the high number of buyers of processed meat products in the US, there is intense competition 
between businesses in the meat, beef, and poultry processing industry. 

While it is reasonable to characterize the beef processing market as competitive in 
operation (i.e., validating the use of supply and demand) the high concentration might suggest 
more of an oligopolistic structure. This could offer the instructor an opportunity to engage 
students in discussion. If the Excel model was presented early in the semester, as part of the 
introduction to supply and demand dynamics, the instructor might revisit the model again in 
the term as monopoly and oligopoly markets are introduced. Discussion, for example, could 
center around what might change if the beef market were oligopolistic. Would we expect a labor 
shortage of the type experienced during 2020 that could impact market supply? An argument 
could be made that a reduction in supply would certainly take place and, even in an oligopoly 
market characterized by “sticky” prices, as modeled by Sweezy’s kinked demand curve model, 
firms would eventually have to increase prices if labor costs were sufficiently large.

8. Conclusion

The purpose of this paper is not to support or refute the claim that meat processors 
engaged in anti-competitive behavior in 2020. It is simply to allow students to read news articles 
more critically in the business press and to be wary of an inclination to dispense with supply 
and demand dynamics too quickly. Indeed, supply and demand economics, while deceptively 
straightforward, can, with a little additional thought, be a very powerful tool for explaining the 
world we live in. Once we have exhausted the insights it provides, then it may be advisable to 
dig further into market conditions to see if something other than competitive forces is at play.

Incorporating supply chain links into a basic supply and demand framework can be 
a very fruitful avenue for both students and instructors to consider. This spreadsheet is, we 
believe, a reasonable step in that direction. While it is limited to shocking supply conditions 
in an intermediate market, it does serve to provide insights into the inter-linkages in markets. 
One could expand on this framework by introducing other sources of supply and/or demand 
shock. For example, this spreadsheet could be modified to allow for a demand shock in the 
intermediate market or shocks upstream or downstream. It might take a bit of coding to do so, 
but perhaps, as we certainly hope, this example provides a “shell” to build upon.

As we have all learned from the recent pandemic, supply chains are vital to the sustained 
functionality of economic systems. When a link in the supply chain is disrupted, disequilibrium 
can result. This Excel model is a powerful yet intuitive way for students to learn about the 
interconnected nature of supply chains and to critically assess the dynamics of economic 
systems.  

There is a large and growing number of spreadsheet models like ours that are potentially 
valuable learning tools. However, evidence as to the effectiveness of all these models is sparse. 
By way of future research, it would be beneficial to develop empirical tests to determine if 
there are measurable increases in learning by utilizing such spreadsheet applications. For 
example, given a sufficient number of instructors willing to adopt our spreadsheet model, one 
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could set up a Random Control Trial experiment to see if a treatment group required to use our 
spreadsheet, experienced learning outcomes that were significantly different than a control 
group. While such an experiment is beyond the scope of this paper, such analysis would be a 
valuable contribution to pedagogical research.
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Appendix: Inputting a Scroll Bar in Excel

	 To insert a scroll bar in your spreadsheet, click on the Developer tab on the ribbon (if 
the Developer tab does not appear on the ribbon, then go to File>Options>Customize Ribbon. 
Under the main tabs, click Developer). Then you should see a dropdown icon labelled “insert.” 
Locate the small icon with an up and down arrow and click on it. Position your cursor over the 
cell or cells you want the scroll bar to appear (in our case cell K31). Once sized to your liking, 
your scroll bar will appear.  Next, link the scroll bar to the values in the worksheet to create 
animated graphs.  To accomplish this first right click on the slider of the scroll bar to open a 
window. Click on Format Control at the bottom of the window. A Format  Control  dialog  box  
opens  up.  Under  the  control  tab,  enter  the  following values:  0  for Minimum Value, 20 
for Maximum Value and 1 for incremental change. Finally enter the address cell $J$31 for cell 
link. Click OK. Now the slider of the scroll bar can be adjusted from a value of 0 to 30 with an 
increment of 1 and its positional value is shown in the cell $J$31 on the worksheet.


